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Maintenance 8
In this lesson:

• Maintenance - Why Bother?

• Backup

• Rebuild

• System and Other Important Reports

• Database Utilities (DBUTIL.EXE)

• Dealing With Errors

Maintenance - Why Bother?

Maintaining your TeleMagic installation is very
important for two reasons:

• It protects your data, which is the lifeblood of your
work. Just think about the amount of work
required to re-enter all of that data!

• It allows TeleMagic to operate at the best speed
possible.

There are other reasons, but just the two mentioned
above should be enough to make you think about
maintaining your TeleMagic installation.
Unfortunately, TeleMagic Technical Support hears
horror stories from users who have not performed
maintenance on regular basis. As important as
maintenance is, some people either forget or ignore
these warnings. When the worst time for a problem
arrives, they are not prepared.

Note: Only perform maintenance to your TeleMagic installation if you are the system
administrator, or if you have been assigned to perform maintenance by the system
administrator!

Backup
Whenever data is critical to you, you should always perform backups on a regular basis.
Since there is a backup program supplied with every copy of Windows, TeleMagic does not
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have its own backup routine. You may also be using a special backup program depending on
the type of backup media/method you are using. You will need to know what needs to be
backed up, and how often a backup should be performed.

Let’s look at how often a backup should be performed. If your data is critical to you, and your
TeleMagic installation is very active (in other words you add, change, and delete information
often) you should probably back up daily. If you decide that your TeleMagic installation is not
that active, or the data is not that critical, you should back up at least one time each week.

Next, let’s look at what should be backed up. It is recommended that you back up the entire
installation of TeleMagic and all of the data files every time. If, however, you want to save time
and storage space, you could back up only the data files. The data files are those files with
*.DBF, *.FPT, *.CDX, *.FRT, and *.FRX file extensions.

Note: Remember, if you have a problem that can only be solved by restoring from a
backup, the backup that you will probably have to restore will be the entire
TeleMagic installation rather than just the data files.

Rebuild
Rebuilding is an extremely important aspect of TeleMagic. By using rebuild on a regular basis
you are able to make sure that your database(s) and other aspects of the program run at peak
efficiency.

There are two types of rebuilds:

Internal rebuild, which is accessed from the File menu.

External rebuild, which is run outside of TeleMagic.

While both versions of rebuild work identically, the external version has some special
capabilities based on what has happened in your TeleMagic installation and what special
commands you issue to it.

When is rebuild important? Whenever you make a change to the structure of your database,
such as adding or changing fields, you must rebuild so the database knows how to deal with
the changes. In addition, it is important to rebuild after creating or revising indexes, and a
special rebuild is included right in that portion of the program for that purpose.

If you are rebuilding the entire TeleMagic installation, TeleMagic requires that only one user
(the one running the rebuild) be running TeleMagic. The others must exit TeleMagic before
starting the rebuild. Users will also not be able to log in during a rebuild. However, if you are
rebuilding only a single database, for example after adding fields, other users may continue to
work in other databases.

Another important purpose of rebuild is to recreate a supervisor user if all of the supervisors
are removed from that group. If that has happened, rebuild will notify you that this situation
has occurred and will automatically create a user with the User ID of TST and a special
password.

Here is the Rebuild dialog box:
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Setting Contents

Start Now / Delay Until / Start
Time / Start Date

If you want to rebuild immediately, leave Start Now
selected.

If you want to delay the rebuild until a future date/time,
select Delay Until. Enter the start date and time for the
rebuild.

On completion / Run Rebuild
Report / Print Full Report / Print

Errors Only / Quit TeleMagic

Mark Run Rebuild Report to print a report after the rebuild
has completed. Select Print Full Report to print a
complete report or select Print Errors Only to print only
the errors found.

Mark Quit TeleMagic to exit TeleMagic at the end of an
internal rebuild. This option is not available for external
rebuilds.

System Mark the appropriate check boxes to rebuild different
parts of TeleMagic. To perform a complete rebuild,
mark all of these check boxes. To rebuild a certain item
or group of items, mark only the appropriate check
box(es) and click the button(s) to select certain items to
be rebuilt:

Mark System and TeleMagic will rebuild the system files.
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Setting (cont’d) Contents (cont’d)

Database / Database button Mark this check box to rebuild one or more databases
and associated components. If you want to modify the
default settings, click Database. Select the databases
to be rebuilt. If this is an internal rebuild, the currently
open database will already be selected by default.

For each database selected, the contact data, filters,
export formats, import formats, Quick Lists, report file
list, and views files are selected to be rebuilt by default.

If you want to have all of the calculated fields
recalculated as part of the rebuild of the selected
databases, mark the Calculated Fields check box. If this
option is selected, the time needed for the rebuild will
increase.

By default, the entire database(s) selected will be
rebuilt. As an alternative, you can select to rebuild only
a particular database level. This is only recommended
when you have changed something on one particular
level of a database and only that level requires the
rebuild. However, keep in mind that this will apply to all
of the databases selected. If you want to rebuild only
one level of one particular database, just perform a
rebuild on it alone.

Global / Global button Mark this check box to rebuild the global tables. If you
want to modify the default settings, click Global to
access your global files. Global files include the list of
databases and security settings for all users, groups,
records, and fields. Select the files to be rebuilt.

User Tables / User button Mark this check box to rebuild the user tables. If you
want to modify the default settings, click User to access
your user files. Select the files to be rebuilt.

Floating / Floating button Mark this check box to rebuild the floating tables. If you
want to modify the default settings, click Floating to
access your floating files. Activities, user-defined list
boxes, function keys, toolbars, and scripts are all saved
in floating files. Select the files to be rebuilt.

DSS Tables / DSS button Mark this check box to rebuild the Data Synchronization
Server tables. If you want to modify the default
settings, click DSS to access your Data Synchronization
Server-specific files. The rebuilding of these files can
also be done through DSS.
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Setting (cont’d) Contents (cont’d)

Automation Server Tables Mark this check box to include the Automation Server
tables with their current settings in the rebuild. The
rebuilding of these files can also be done through the
Automation Server.

Reindex / Pack and Reindex Select Reindex to only update index files. If this option
is marked, no deleted records will be removed from the
databases being rebuilt.

Select Pack and Reindex to update index files and
streamline the tables so they take up less storage
space. If this is marked, all deleted database records
will be removed from the databases being rebuilt. Pack
and Reindex is the default.

OK button Click here to begin the rebuild. If you are delaying the
start of the rebuild, a dialog box will open indicating the
date and time the rebuild will start.

In addition to the manual settings, the external rebuild allows you to give special commands to
the rebuild program called command line parameters. You can use these settings when you
start the REBUILD.EXE program by including the desired parameter(s) in a Windows Run
command:

Here is a list of the Rebuild command line parameters and what they do:

Setting Results

/R This will bypass the Rebuild dialog box and perform
the rebuild directly with the default settings.

/RE This parameter will bypass the Rebuild dialog box
and delete the error log. Use it in place of the /R
parameter.

/RC This will bypass the Rebuild dialog box and
recalculate calculated fields. Use it in place of the /R
parameter.
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Setting (cont’d) Results (cont’d)

/REC This will bypass the Rebuild dialog box, recalculate
calculated fields, and delete the error log. Use it in
place of the /R parameter.

/PRNTERR This is used to limit the default rebuild report to only
detail any errors that are encountered during rebuild.
This parameter must be used with the /R, /RE, /RC,
or /REC parameter. (Example: /R /PRNTERR)

/NOREP This will turn off the default report option. This
parameter must be used with the /R, /RE, /RC, or
/REC parameter. (Example: /R /NOREP)

System and Other Important Reports
System Reports provide another reliable way to check TeleMagic’s current status on a
Network system. Each of these reports can be accessed from the Reports menu, by
selecting System Reports and opening the submenu. Supervisor users have full access to
all of the reports, and non-supervisors have access to only certain reports. A Supervisor
user’s version of the menu is seen below:

Most of these reports will print immediately when selected, without allowing you to view it on
screen. Here’s what each report will tell you:

Use this System
Report:

To Find Out About:

Database Structure
Report

This report shows all field names, types,
sizes, etc. in a selected database. This
report is only available to Supervisors.
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Use this System
Report: (cont’d)

To Find Out About: (cont’d)

Group Security Report This report shows all Security Groups and
their security access/rights in TeleMagic. It
also shows which users belong to which
Security Group. This report is only available
to Supervisors.

User Security Report This report shows which Security Group a
particular user belongs to, and what
access/rights that user has. This report is
only available to Supervisors.

System/Database
Preference Report

This report shows the System and Database
Preference settings for every installed
database in TeleMagic. This report is only
available to Supervisors.

User Preference Report This report shows the Preference settings for
individual users. This report is available to
Supervisors with all features, while non-
Supervisor users can access the report but
only print their own Preference settings.

Error Report This report shows the detailed listings of
every error report on file, including the system
status and settings when the error occurred.
This report is available to all users.

It is not recommended that you print a
detailed error report unless absolutely
necessary, as these can be very large.

User List This report shows the users in this installation
in alphabetical order by User ID. This report
is only available to Supervisors.

List Box Report

The List Box Report allows you to view or print a report showing the details of the current
field’s list box or for all of the list boxes for the fields of a particular database level. This report
can be accessed from the Reports menu by selecting List Box Report. You can select the
database on which to report, as well as the database level. The report can be previewed or
printed. This report is available to all users.

Fax Reports

The Fax Reports option allows you to print the same reports while in TeleMagic as you can
print if you are in the Automation Server. This report can be accessed by selecting Fax
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Reports from the Reports menu. Supervisor users have full access to all of the features of
this report, and non-Supervisors have limited access.

Database Utilities (DBUTIL.EXE)
Database Utilities is an external program that comes with TeleMagic and is copied to the
\PROGRAMS folder when TeleMagic is installed. This program is designed for use by a
System Administrator, your TeleMagic reseller, or someone who has been instructed by them
or TeleMagic Technical Support. Its purpose is to perform repairs and to manipulate your
TeleMagic installation in special ways. Most of its features are restricted to Supervisor users
only.

When you start Database Utilities you see a warning screen. After you click I Agree to
continue, the Login dialog box will appear. As previously stated, most of the features in
Database Utilities are restricted to Supervisor users only, so enter a Supervisor's User ID.
When the user's ID and password have been entered, the main screen will open:

Database Utilities contains several utilities. Here is a brief explanation of each:

Activity Menu

Verify Duration/Due Time Utility

If your activity table contains invalid times or durations which have been replaced with an
asterisk, this utility will automatically detect and repair them. Typically, these invalid times or
durations were generated by add-on products not following published TeleMagic standards,
importing improper data into these fields, or (under certain circumstances) from prior versions
of TeleMagic. There are no user inputs associated with this utility. While running, a status
bar will be displayed. You will be informed when the utility has finished and what errors were
found, if any.
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Comment ID Regeneration Utility

This utility is used prior to installing Data Synchronization Server at a particular site. It is
possible for activity comment IDs to be duplicated. This condition will occur when a site is
initially synchronized and whose Site ID is, or has been, identical to another site already
under synchronization. This will result in some activities being associated with the wrong
comments. To avoid this, the Site ID of one of the sites must be changed and the Comment
ID Regeneration utility run prior to initial synchronization.

Note: To avoid this the System ID has been included as part of the comment ID. This
feature was implemented in comment IDs generated on activity import in version
3.5a.

Global Menu

Path Update Utility

TeleMagic contains several internal references to the location of its primary directories. If you
move your TeleMagic installation from its original path, it will be unable to locate its
directories. When this occurs, you will not be able to access TeleMagic.

The Path Update Utility allows you to tell TeleMagic the new path to the global directory after
it has been moved.

Note: This utility does not actually move your installation of TeleMagic. You must move
TeleMagic to the desired target location before updating the path.

Registration Transfer Utility

This utility will transfer registration information from an established, registered installation to a
new installation. This feature is intended to address issues experienced when an installation
has become damaged, corrupted, or unstable and re-installation is required. The registration
status of the source installation will be deleted.

Word Processor Upgrade Utility

This utility is used to change the default word processor used for previously created
TeleMagic documents. When you create a document in TeleMagic, the program remembers
which word processor you selected. It will only allow you to use that same word processor for
that particular document. If you upgrade your word processor (or add another word
processor) and want to use it with your existing documents, you must first run this utility. For
example, if you were using Word 6 as your word processor and then upgraded it to Word
2000, you would use this utility so you will be able to open and use them when inside of
TeleMagic.

Note: You must have the newer word processor installed and selected as a word
processor in TeleMagic before attempting to use this utility.
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Note: This utility does not convert the internal structure of the document. If the newly
upgraded (or new word processor) uses a different internal structure than the
original word processor, that structure is not changed by this utility. Most word
processors will convert the old structure to the new structure when the document is
opened, and then allow you to save the document with the new structure.

Contact Menu

Database Integrity Check

TeleMagic uses a special Contact ID that is assigned to a contact record when the record is
first created. In addition, a record may have a fixed relationship with other records. For
example, it may be a Level 2 child record of a Level 1 parent record.

Under certain circumstances the TeleMagic database may become corrupted. This corruption
could result in Contact IDs being damaged, or links to related records being broken. Records
with the latter condition are referred to as "orphans". Records can become corrupted for many
reasons. Some of the most common causes are:

• Using add-on products that do not comply with TeleMagic's published standards.

• Closing TeleMagic improperly, such as by turning off the computer without first exiting
TeleMagic. This may damage TeleMagic files, or leave one or more TeleMagic files
open.

• Experiencing a power outage or other power fluctuation, which could result in damage
to TeleMagic files.

The Database Integrity Check allows you to fix any Contact IDs that might have been
damaged in your databases. In addition, you can identify orphaned records and reconnect
them to the proper parent record (if possible). If a file has become an orphan due to a bad
Contact ID, it will not automatically be reconnected to its original parent. A new parent will be
created and the file will be associated with the newly created parent.

Database Repair

The Database Repair function will analyze and attempt to fix any problems within a .DBF file.
It was primarily designed to fix corrupt headers in .DBF files.

Use Database Repair only if you have tried rebuilding the file(s) with no success. If Database
Repair is unsuccessful, you will have to restore the database file(s) from an earlier backup.
Database Repair should never be run on a database which is currently in use. It is highly
recommended that all users exit any database being repaired, even if you are only generating
a report and not attempting repairs.

WARNING! We strongly recommend that you create a backup of the installation before using
the Database Repair function.

Template Maker

Template Maker is designed to allow you to take a TeleMagic database and make a template
from it. What is included in a template? Any settings that are database-specific will be in the
template, including:

• Customized Views
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• Field Structure

• Contact Records

• Notebook Records

• Indexes

• Filters

• Import/Export Format Files

• Custom Reports

• Quick Lists

• Reports Menu Configuration

• In Directory Preferences, if the following are set to database-specific for any users,
they will also be included in the Template:

• Toolbar Configuration

• Function Keys

• List Boxes

Note: Activities linked to contacts in the database will not be included in the template. If
you wish to include linked activities, you can do so through Data Synchronization
(if the installation in which the database currently exists is the central site, and it is
being sent to an installation that is a remote site). Alternatively, when you create
the template, do not elect to include contact records. You can then export the
contact records with the linked activities to a file which can be imported into any
new databases created from the template.

What is not included in a template? Any settings that are user-specific or installation-specific
(for example, security settings) will not be included in the template.

The Template Maker creates three files with the file name DBTYPES, but each have different
file extensions (.DBF, .FPT, and .CDX). All three files must be present to install a database
from a template. These files are all you need to install the template at another location. After
the template has been created it can then be given to any other TeleMagic installation to be
installed and used.

Note: The TeleMagic installation into which you want to install the template should be
running the same version of TeleMagic as was used to create the template.
However, in most cases the latest version of TeleMagic will install a template
created in the version of TeleMagic immediately preceding it. For example,
TeleMagic V5 will install templates created in TeleMagic V4.5.

Address Correction

TeleMagic has formed a partnership with Mailnet Services to provide users with a valuable
service. Address Correction allows you to have the most accurate and updated information
possible on your contact records. You can update area codes, make sure the address you
have is accurate, check ZIP codes, and other useful services. Users will have to set up an
account with Mailnet Services to use these features.
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Once an account is set up, you can then use Database Utilities to send a packet of
information from a particular database level (optionally, these can be filtered records, but all
records must be from the same level) to be updated by Mailnet Services. You will set up a
profile detailing the records and fields to send, and then upload it to Mailnet’s FTP server. You
have the option of 24-hour or 72-hour turnaround.

Note: You can perform Address Correction on only one level at a time.

Later, you will use Database Utilities to download the packet from Mailnet’s FTP server and
process the packet.

WARNING! The packet containing the updated contact information will overwrite the existing
contact information (that was selected to be updated) in the database, even if
information has been updated since you sent the packet to Mailnet Services.

For more information about Address Correction, please see the on-line help.

DSS Utilities

Packet Viewer

The Packet Viewer allows you to view the contents of your Data Synchronization packets.
This is useful in situations where the records do not appear to be updating as expected after
being synchronized. Packet Viewer examines the packet and generates a report which
provides general data concerning the system, site, users, deleted records, security groups,
and scripts. The report also provides descriptive data of records and e-mail, but does not
reveal content. Packets going from a satellite to a central site will not include detailed
information concerning the central site, but will indicate that the target is a central site. Once
generated, the report can be printed or saved as a text file.

Rejected Records

Records may be rejected during the synchronization process for any of several reasons:

• The record was changed at the remote after being deleted at the central site.

• The record did not meet a filter requirement.

• The record is an orphan. (It is a subordinate level record with no valid parent.)

• The site is not accepting new records.

The contents of rejected records will be saved in TeleMagic's DATA subdirectory in files.
These rejected files will be named according to the convention REJECTx.DBF, where x
indicates the level (1, 2, or 3).

The Rejected Records Viewer allows you to examine the contents of these rejected files. You
will then be able to assess the value of the rejected data and take steps to retrieve or
reconstruct it, if appropriate.

Export/Import Corporate Licenses

This feature is only available if you have a corporate license for DSS sites, and it is used at
the central site before performing an update. It allows you to export the corporate licenses to
a special file before the update is performed, and then allows you to import the corporate
licenses after the update has finished.
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Uninstall DSS

Select this item to remove Data Synchronization Server from your installation. You will
receive a message asking you to confirm the removal of DSS. Click Yes to remove Data
Synchronization Server.

System Utilities

Copy and Register System Files

Note: This option should only be used if directed to do so by technical support personnel.

Select this item to check the \WINDOWS\SYSTEM directory (\WINNT\SYSTEM32 in Windows
NT and 2000 installations) for supporting files used by TeleMagic (a list of these files can be
found in the TMSYS.INI file). If these files do not exist or are out-of-date, they are copied from
the TeleMagic installation. TeleMagic then updates the registry entries for all files that can be
registered.

This utility should be run before TeleMagic is started for the first time after reinstalling
Windows. This utility may also be used if errors related to accessing any of the noted files are
experienced.

Dealing With Errors
Sage U.S. Holdings, Inc. is careful about testing and re-testing our products before they are
released. However, due to the complexity of this program, sometimes we may miss
something. Or, as is more often the case, something happens in the machine running
TeleMagic that causes an error. If this occurs, an error may be hardware-related or
Windows-related.

If an error happens, you will usually receive some sort of error message, either from
TeleMagic, from Visual FoxPro (the programming language in which TeleMagic is written), or
from whatever version of Windows you are using. If errors are found, check the
Troubleshooting section of the System Administrator Guide and try to find and fix the
problem.

To help you in your troubleshooting, you can record an error as it happens by creating an
error log. Error logs pop up automatically when most errors occur, and they provide a
convenient way for you to record a system problem. In addition, the error log will record
system information at the time of the error, as well as the contents of critical files such as
AUTOEXEC.BAT and CONFIG.SYS. This error log can be very useful in determining a
problem if you need additional assistance from your TeleMagic reseller or from TeleMagic
Technical Support.

If an error log does not appear when you experience an error and you would still like to create
an entry in the error log, select Log the System Status from the Help menu and a Voluntary
System Status dialog box will be displayed:
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Record what you did (keystrokes, selections, etc.) before the error as precisely as possible.
Then describe the error that occurred. When you’re finished filling out the report, click OK
and TeleMagic will take a “snapshot’” of the system at the time of the error.

To view the error log later, select View System Log from the Help menu. You will see a
browse table with all of the logged errors. To see the information concerning a particular
error, double-click it. A dialog box will appear that will let you look at any of the system
information stored with the error entry, and the log entry itself. While in this area you can
create a report of the error log. To view a report for all of the log entries, use the Error Report
mentioned earlier in this chapter as part of the System Reports discussion.
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Exercises 

1. What are the two methods of printing error log entries?

2. What are the two methods of rebuilding and what is the main difference between them?

3. What are the two main reasons for maintaining your TeleMagic installation?

4. Which system report shows the preference settings for individual users?

5. If you are doing a partial backup, what are the file extensions that should be backed up?

6. What is the command line parameter that allows you to run an external rebuild without
printing a report?

7. What type of information is stored in the global files?

8. True or False: If you have a major problem you will probably need to restore data from a
full backup.

9. What type of information is stored in the floating files?

10. True or False: An error log will contain the contents of special files such as CONFIG.SYS
to assist in determining the cause of the error.
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Chapter 8 Notes


